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1. General Information 

Electrical Input to Power Supply 100-240VAC, 50-60Hz 

Input Current Rating of Power Supply 1.0 Amp 

Electrical Output from Power Supply 24 VDC 

Output Current Rating of Power Supply 1.5 Amp 

Recommended Computer OS Windows 10 

Environmental Conditions Maximum Operating Temperature 25ºC 

20% - 80% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree II 

Data Connections 1 – USB 3.0 (SS) for camera/PC communication 

1 – USB for Main system/PC communication 

USB hubs may be used for computers that have insufficient 
ports, as long as the hub supports and provides USB 3.0 
connections. 

System Assembly 

Please see instructions in Appendix A for details on system assembly.  See Appendix B for installing the 
software, and Appendix C for details on setting up the host computer. 

Connections to Supply 

Connect power cords to properly grounded 100-240VAC power source to ensure safe operation. Ensure 
that the power cords are always easily accessible. The use of an Uninterruptible Power Supply (UPS) is 
recommended to protect against data loss. 

Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual to prevent injury 
and/or damage. 

Operating Controls 

There are no manual controls on the MicroTester G2 main unit. Both the camera and microbeam assembly 
contains motorized X, Y and Z adjustment stages to position and focus the camera view.  In addition, the 
camera brightness can be controlled by setting the software interface.  

General Maintenance 

Clean the system as needed with mild soap and water or alcohol-based cleaning solutions. 
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Approvals and Certification 

We declare that the CellScale MicroTester G2 complies with the requirements of the Electromagnetic 
Compatibility Directive, 2004/108/EC by demonstrating compliance with the following standards to the 
extent applicable: 

EN 55011: 2008 Class A 

EN 61000-3-3: 2008 

EN 61000-4-2: 2009 

EN 61000-4-3: 2006 (+A1:2008 +A2:2010) 

EN 61000-4-4: 2005 (+A1: 2010) 

EN 61000-4-5: 2006 

EN 61000-4-6: 2009 

EN 61000-4-8: 2010 

EN 61000-4-11: 2004 
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2. Parts 

Tools 

Small flat head screwdriver 

SAE hex wrenches: 5/64”, 3/32” 

Metric hex wrenches: 1.5mm, 2mm, 2.5mm, 3mm 

Rectangular flat wrench 

Basic Components 

Main Assembly 

Piezo Stage Controller 

Position Sensor Controller (with LED power supply) 

USB 3.0 Colour Camera 

Motorized XYZ Camera stages and Controller 
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3. Testing Terminology 

The MicroTester G2 is designed to apply compressive loads to small test specimens 50 to 2000 m in size. 
Typical specimens include biological tissue samples, scaffolds, cell aggregates, or hydrogel microspheres. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different degrees 
and at different rates. There are three main reasons for doing this: 

Preconditioning - The goal of preconditioning is to restore a specimen to its physiological or in vivo 
state. During the process of specimen storage and preparation, a specimen may swell, dry out, have 
its material fibers realign, or its molecules reorganize. It may take multiple preconditioning cycles for a 
specimen to be restored to its natural state. 

Reproducing Physiological Conditions During Testing - By applying various loads and load rates, 
natural expansion and contraction of a specimen can be reproduced (for example, the pulse pressure 
in an organ). In as much as the physiological conditions can be recreated, the specimen can be tested 
in a more realistic state. 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test profiles to best 
study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is called a 
test cycle. The same test cycle can be repeated multiple times to achieve a certain goal (preconditioning, 
physiological conditioning, or testing); this is called a test set. Finally, a test sequence is made up of 
multiple test sets.  

 

                    Load        Hold      Recover Rest 
                    Phase      Phase    Phase    Phase 
 
 
 

Cycle1          Cycle2  
 
 
 Set1                       Set2  

 
 
 

Time 

Displacement 

or Force 

Test Sequence 
 
 

 

 

The above example describes the following: 

• The entire diagram presents a full test sequence.  

• Within that sequence, there are two test sets.  

• Within the first set, two identical test cycles are implemented to bring the sample to a satisfactory 
in vivo state.  

• Finally, the second set is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are four phases within a cycle. Each 
phase serves a specific purpose: 

Loading - During the load phase, a deformation is 
applied to the specimen. The deformation can be 
specified either in terms of force applied or 
displacement achieved. 

 

Holding - The deformation can be held for a given 
duration. The duration for which it is held is dependent 
on the nature of the testing. 

 

Recovering - The recovery phase is the time during 
which the force being applied to the specimen is 
removed. The duration of the recovery time is 
configurable and dependent on the nature of the 
testing. 

 

 

Resting - Finally, the rest phase is the time between the end of one cycle and the beginning 
of the next. Some tests may specify a short recover time, while others may specify a longer 
time. The duration is configurable and dependent on the nature of the testing. 
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Control Modes 

There are two control modes which define the basic approach to a given test: displacement control and 
force control: 

Under displacement control, the displacement of the specimen is predefined. The MicroTester 
G2 compresses the specimen until the predefined displacement is achieved. The force required to 
achieve the displacement is an output of the test. 

Under force control, the force applied to the specimen is predefined. The MicroTester G2 
compresses the specimen until the predefined force is achieved.  The displacement required to 
achieve the force is an output of the test. 

Control Functions 

The MicroTester G2 makes it possible to test specimens under several control functions with Displacement 
or Force control modes: 

The ramp function applies the displacement at a constant nominal rate. This is equivalent to a 
constant engineering or nominal strain rate.  

The step function achieves and maintains the desired force as quickly as possible. The amount 
of time it takes to achieve the desired force depends on the material being tested and the control 
settings.   

 

                               Ramp                Step      
 
 

Time 

Displacement or Force             
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4. System Overview 

The MicroTester G2 is a mechanical test device that can be used to test the properties of a variety of tissues 
and materials. 

 

 

 

 

A Microbeam. 

B Actuators. 

C Imaging system. 

D Fluid Bath (Test 
Chamber) 

The main components of the device are the load application microbeam, the actuators, the imaging system, 
and the fluid bath/test chamber. 

Microbeam 

The microbeam is rigidly fixed to the vertical actuator (which is under closed loop control).  It has a flexible 
shaft that is typically between 30mm and 50mm long and can be made from a length of metal, glass, or 
plastic with a circular or rectangular cross section.  Circular tungsten beams are supplied with the system.  
At the end of the shaft is a rigidly fixed compression plate.  This plate is typically made from a small square 
of micro-cut stainless steel and is adhered to the end of the shaft.  Cyanoacrylate and adhesive accelerator 
are provided for this purpose.   

The microbeam is used to apply deformations to the test specimen while measuring the applied forces.  
The deformation is determined by measuring the difference between the current tip position and the initial 
tip position.  These measurements are obtained in real time at a frequency of 5 Hz by image tracking 
techniques.  The applied force is determined by calculating the deflection of the microbeam (the difference 
between the displacement of the tip and the displacement of the actuator).  The displacement of the actuator 
is obtained directly from a position feedback device (displacement sensor) mounted to the actuator. 

Because the microbeam is used for 2 purposes (apply deformation and measure forces), an iterative control 
scheme is necessary to achieve the desired result.  For example, if a tip displacement of 100µm is desired, 
it is unknown at the start of the test how much actuator travel will be required to move the tip by this amount 
since some of the stage travel will result in tip displacement and some will result in microbeam bending. 

The microbeam can have a variety of constructions and must be tailored to the force ranges that are to be 
measured.  If the microbeam is too stiff, then the beam deflection will be too small.  This has a negative 
influence on the force resolution.  This is a result of the position resolution of the base and tip displacement 

 

 

 

 

D 

B 

A 

C 
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measurements, which are both approximately 0.1µm.  For example, if the microbeam only deflects 2 µm 
during the test, then the force resolution is only 1/20 of the maximum force. 

Conversely, if the microbeam is too flexible, then the deflection will be too large.  This can have a negative 
influence on the reaction time of the device and on the parallelism of the compression plates.  With more 
deflection of the microbeam, the actuator must travel further to achieve the desired tip displacement.  Since 
the velocity of the actuator is limited to about 2mm/s, this can cause unwanted delays.  Also, as the beam 
deflects, the top compression plate can become slightly less parallel to the lower compression plate.  In a 
test with a moderate microbeam deflection of 100µm, this effect is very small, since the beam is typically 
over 30mm long.  In a test with a large microbeam deflection of 2mm, this effect becomes more significant. 

The table below shows a list of the microbeams that come with the MicroTester G2 system and the 
appropriate maximum forces for each diameter.  A chapter containing details of the force calculations can 
be found later in this manual. 

 

Diameter (mm) 0.0762 0.1016 0.1524 0.2032 0.3048 0.4064 0.5588 1.0160 1.5748 

Modulus (MPa) 411000 411000 411000 411000 411000 411000 411000 411000 411000 

Typical Force 
Resolution (µN) 

0.012 0.038 0.191 0.604 3.056 9.658 34.52 330.54 1907.88 

Recommended 
Max Force (µN) 

4 11 57 181 917 2,897 10,536 99,162 572,363 

 

 

 

 

 

 

 

 

Microbeam with Platen   
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Microbeam Actuators 

There are 2 actuation systems integrated to the microbeam assembly.  The first system is comprised of the 
2 piezo motor driven actuators that are used to position the microbeam in plane before the start of the test.  
The actuators are controlled by the user, using on-screen controls in an open loop jog mode.  There is no 
absolute measurement of how far they have been moved since feedback is based on user interpretation of 
the live on-screen image. 

The second actuator system is the closed-loop, piezo motor actuator that is used to move the microbeam 
vertically.   It is driven in a user-controlled jog mode during setup and then under computer control during 
the test (specially modified systems are also available to track horizontal displacement as well, in which 
case the horizontal actuator is also under closed loop control).  The actuator used for this purpose is 
identical to the other 2 axes, but the system also incorporates a position feedback device.  This 
displacement sensor has 0.1um resolution and allows for the software to determine the displacement of the 
actuator relative to the start of the test.  This motion constitutes the movement of the base of the microbeam.  
The displacement of the base and tip of the microbeam are needed in order to determine the deflection of 
(and hence the force applied by) the microbeam. 

Imaging System 

The imaging system is comprised of a USB digital camera, a zoom lens, and a motorized XYZ stage 
assembly to allow position adjustment and focusing.  The camera has a resolution of 2048 X 2048 pixels 
and can match the control frequency of 5Hz.  The zoom optics allow for a field of view ranging from 
approximately 0.4mm to 12.0mm. 

The imaging system comes with interchangeable tubes and auxiliary zoom lenses for 1X and 2X 
magnification.  How to change between lenses can be found in Appendix E. 

 

   

        
              A Zoom Ring 

                                                            B Ring Light                                                    

B 

A 
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Fluid Bath 

The fluid bath contains approximately 45mL of fluid and is heated by a resistance foil heater in the base of 
the bath.  The fluid temperature is controlled by an onboard temperature controller that communicates with 
the PC via the USB connection.  The temperature of the bath is measured by a solid-state temperature 
probe with a temperature resolution of 0.1°C.   To function the MicroTester G2 software will log the actual 
temperature of the fluid.  To enable the controller to heat the fluid, the “HEATER” switch beside the main 
power switch must be turned on to illuminate the amber heater light. 

MicroTester G2 Tip: Temperature Probe 

The temperature controller works best if the temperature probe tip is completely 
submerged and not touching the side of the fluid chamber. 

 
The bath is a clear polycarbonate dish which allows for visibility from all sides, the main imaging system is 
setup to image the front side of the dish, where the compression platform is setup in the image below.  The 
compression plate is typically made of a stainless-steel block and is flush with the front window. 
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Software Overview 

The software included with the MicroTester G2 system is called MicroTester G2.  It is divided into two 
modules: a data collection module and a review and analysis module.  The data collection module is used 
to set test parameters, enable specimen loading and testing, and monitor test progress.  The screen layout 
for this module is shown below: 

 

 

 

Test 
Parameters 

 

 

 

 

 

 

Live 
Output 

 

  

          Live Video             Live Graphs 
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The review and analysis modules are used to playback accelerated or decelerated test images, perform 
image analysis and tracking, and output movie files for presentation purposes.  The screen layout for this 
module is shown below: 

 

 

 

Image List 

 

 

 

 

 

Image Playback 

 

 

Image Tracing 

 

 

 

Data Overlay 
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Output Files and Data Structures 

For each test, the MicroTester G2 creates and saves three file types. The following table describes the five 
file types for a project named “Sample1”. Output from this test would be found in a “Sample1” output 
directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and 
displacement values. 

.jpg files Captured images such as Sample1.0001000.jpg, which would correspond to an image captured at 
1000 milliseconds from the start of the test. 

 

Each test folder will also contain 2 subfolders.  The “Logs” subfolder contains a text file of the content of 
the text dialog portion of the main screen.  It is useful as reference to troubleshoot problems with your 
system, should they occur. 

The “Tracking” subfolder is initially empty.  If tracking is done on any of the images in the test folder using 
the “Analyze and Review” software module, there will be data files that contain the tracking information 
stored in this directory.   

While using the “Analyze and Review” software module, you may create additional data files such as text 
files (*.csv) containing tracking results, images with force data or tracking results overlaid (*.wmf), or movie 
files (*.avi).  These additional files can be stored in the test directory or elsewhere on your computer’s hard 
drive without interfering with the software application (once created, they cannot be opened by the 
MicroTester G2 application). 
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5. Setting Up & Starting a Test 

Overview 

Setting up and running a new test is a simple process made up of both mandatory and optional steps. The 
following list presents all the steps, while the rest of this chapter describes each of the steps in detail. 

Step 1: Start a New Test 

Step 2: Modify the Test Parameters (optional) 

Step 3: Specify the Microbeam properties (occasional) 

Step 4: Load the Specimen 

Step 5: Set the Optics Zoom Level 

Step 6: Adjust the Initial Size Crosshairs 

Step 7: Select a Tracking Point 

Step 8: Execute the Test 

Step 9: Terminate the Test Prematurely (optional) 
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Step 1: Start a New Test 

Launch the MicroTester G2 software, and 
then select Collect New from the File menu. 
In the Create Test From Template dialog, 
perform the following steps:  

1. Select a template that matches the 
type of test you wish to perform. See 
the MicroTester G2 Tip on how to 
select and use a template. You can 
modify the template parameters in 
Step 2, below.  

2. Name your test. The dialog will have 
a default test name. You can use the 
default or rename the test. Each time 
you start a new test, the default name 
will continue to increment the number 
at the end of the name. 

 

3. If desired, you can change the location of the output data. The location of your output data and 
images is determined by specifying a Test Name and Data Directory. The template and data 
directories are user specific (computer login name). Each system user can store their files to a 
different default location. The system uses the last location selected as the default. 

 

MicroTester G2 Tip: Selecting and Using Templates 

How to select a template: Designing an appropriate test sequence is an art that depends 
on both the type of material being tested and the specific material properties you are 
interested in measuring. When first testing a new material, you should expect to have to 
experiment with the settings until the test yields meaningful data.  

The system comes loaded with example templates to help you get started. Selecting a 
template does not lock you into a specific test sequence or protocol – rather a template 
defines a test sequence and settings, all of which can be changed before a test is run. 
Once you have developed a test sequence and settings that are appropriate for the 
material you are testing, you should save these settings using “Save As Template” from 
the file menu. You can then select your template the next time you initiate a test. 
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Step 2: Modify Testing Parameters (optional) 

You can select and modify test parameter sets by clicking on their row in the Test Sequence table and then 
pressing the Edit Set button (or by double clicking on their row).  

 

 

 

When you do so, the Set Parameter 
Editor Dialog will appear.  

Note that displacements are specified 
in either % strain, or μm. Force loads 
are specified in μN, and durations are 
specified in seconds. 

The following table describes each of 
the parameters. 
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Test Parameter Description 

Control Axis Loading is normally applied in the vertical Z-Compress axis.  MicroTester G2 systems that have 
been equipped with a second displacement control axis can also apply horizontal shear loads by 
selecting the X-Shear axis. 

Control Mode Compression tests are typically performed under displacement control.  However, you can select 
the following control modes to achieve specific testing objectives: 

• For creep testing, use force control with a long hold duration. 

• For relaxation testing, use displacement control with a long hold duration. 

Control Function Ramp functions are most commonly used although step functions are also used. 

Compress Magnitude  
(Load Magnitude when in 
Force Control mode) 

Compression magnitude is specified as an absolute position or force relative to the initial state of 
the microbeam.  Positive magnitudes are compressive (the beam moves down). In systems 
equipped to perform horizontal shear testing, positive magnitudes are to the right. 

If you are using Displacement control mode, you can specify the displacement in either µm or as 
a percentage. For example, the displacement on a 1000µm Initial Size specimen can be expressed 
as either 100µm or 10%. 

If you are using Force control mode, you can only specify the force magnitude in N. 

Watch the test results carefully to determine which magnitude setting best achieves your test goals. 

Tolerance For step functions only.   

A step compression is considered achieved when the current microbeam position (or force) is at 
the specified magnitude +/- the tolerance.  A tolerance that is too small may result in unacceptably 
long compression durations and/or instability. 

Recommended values are at least 10 times the force resolution of the beam. (see chapter: Force 
Calculation Formulas for more details). 

Correct Overshoot For step functions only. 

An overshoot is defined as a compression magnitude that is larger than the specified magnitude 
plus the tolerance.  When checked the control software will move the microbeam up and/or down 
until the desired step magnitude is achieved (i.e. recover from overshoot).  When unchecked, the 
control software will consider overshoot as the successful completion of the step function. 

Not correcting overshoot is important for relaxation testing. 

Loading Duration For evenly spaced images, it is recommended to choose a number that is an integer multiple of 
the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or relaxation testing. 

Recovery Duration Recovery Duration is often set to the same value as the Stretch Duration. 

Do Not Recover Select this to skip the recovery phase. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be used to mimic in vivo 
conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the next start to 
overlie each other. 

Data Output Frequency Typically set to the same frequency as the image output frequency. 

Image Output Frequency Typically set to 1Hz for cycles > 30 seconds and 5 Hz for cycles < 30 seconds. 
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MicroTester G2 Tip: Multi-Stage Compression Testing 

Recover phases can be skipped by checking the “Do Not Recover” check box.  For example, a 
set that performed 10% compression with the “Do Not Recover” box checked would result in the 
specimen still being compressed by 10% at the start of the next cycle. 

Multi-Stage compression can be achieved by performing multiple sets that have a “Do Not 
Recover” duration. 

For example, to compress a specimen by 300um in 3 stages of 100um, create 3 separate sets 
(i.e. three separate lines in the test parameter specification table).  The first set should have a 
100um compression magnitude, the second a 200um compression magnitude, and the third a 
300um compression magnitude. (Note the compression magnitude is relative to the start of the 
test rather than the position at the start of the set). 

 

MicroTester G2 Tip: Testing Tissues that Relax Quickly 

For specimens that relax very quickly, it may be necessary to achieve the desired move in 2 or 3 
stages so as not to overshoot and rebound.  What can happen in these cases is that the 
microbeam will achieve its desired displacement, completing the “Compress” phase.  At the start 
of the hold phase, the tendency of the specimen is to relax, causing a drop-in force.  This dropping 
force causes the microbeam to want to unload its elastic energy and hence further deform the 
specimen.  The software will react to this by raising the stage (microbeam base) to reduce the 
applied force and maintain the desired displacement.  The difficulty occurs when the relaxation 
causes these events to happen so quickly that the 5Hz operation of the equipment cannot keep 
up and maintain the desired displacement.  The only remedy is to move the beam part way to its 
destination in 1 or more preliminary moves so that the overshoot that takes place never results in 
the microbeam moving more than its desired displacement. 

 

MicroTester G2 Tip: Applying Preloads 

Preloading can be implemented by creating a set with a force control step function load at the 
beginning of a testing sequence. 

 

MicroTester G2 Tip: Tension Testing 

The MicroTester G2 can be used to perform tension testing by fixing the specimen to the lower 
and upper compression plates.  To achieve this, the compression magnitude should be entered 
as a negative number.   

 

 



20 
 

Step 3: Specify the Microbeam Properties (Occasional) 

Microbeam properties including dimensions and 
modulus must be correctly specified to obtain correct 
force outputs.  You can check and set Beam properties 
by selecting Equipment from the Settings menu or by 
pressing the Equipment Settings button in the Live 
Output section of the main display window.  The 
following dialog will appear. 

Note that the “Beam Length" parameter refers to the 
distance from the fixed end of the microbeam wire (the 
near side of the clamp) to the point of force application 
at the free end under the compression platen. 

The microbeam length described above MUST be 
accurately measured. Calipers or a finely marked ruler 
can be used. 

Standard microbeam diameters and moduli are shown 
in the table below.  Potentially, other microbeams of 
other materials could be used.  Microbeams may need 
to be cut before mounting to between 30-60 mm in 
length.  Scissors or side-cutters may be used for this 
purpose.  

For instructions on preparing and mounting a 
microbeam, see Section 9 of the manual - Mounting 
Microbeams.  

 

Diameter (mm) 0.0762 0.1016 0.1524 0.2032 0.3048 0.4064 0.5588 

Modulus (MPa) 411000 411000 411000 411000 411000 411000 411000 

Typical Force Resolution (µN) 0.012 0.038 0.191 0.604 3.056 9.658 34.521 

Recommended Max Force (µN) 4 11 57 181 917 2,897 10,536 

 

MicroTester G2 Tip: Update Templates After Changing Beam Properties 

It is important to update the beam properties after replacing a microbeam. The beam 
properties are stored in the test template along with the test protocol and other 
equipment settings.  For these updated beam properties to be automatically used the 
next time you start a new test using the same template, you should save these settings 
to a new template using “Save As Template” from the File menu.  
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Step 4: Load the Specimen 

Loading the specimen under the microbeam takes a certain 
amount of practice.  It is important to position the specimen 
as close as possible to the front glass so that it can be imaged 
correctly.  The end of the microbeam can be used as a 
micromanipulator for this purpose.  The microbeam can be 
moved using the manual Actuator Controls which allow the 
user to move each actuator independently at a variety of jog 
speeds.    

  

 

MicroTester G2 Tip: Viewing the Specimen in the Live Video Window 

The optics and camera are mounted on three axis manual stages which can be used to 
focus and position the optics and camera to obtain optimal imaging.   

The optics have a manual zoom control detent which can be used to change the 
magnification of the image and increase the field of view. It is often helpful to work at low 
zoom levels for loading a specimen.  The zoom level can then be increased once the 
specimen is properly loaded. 

Camera Shutter and Gain can also be adjusted (on the Equipment Settings dialog) if the 
live image appears too bright or too dark. See Section 6 for more details. 

 

MicroTester G2 Tip: Microbeam Position 

For most testing it is desirable to move the microbeam forward until it touches the glass 
and then move it backward a very small amount.  It is usually obvious when the 
microbeam touches the glass because it will jump suddenly in the live image.   

 

  



22 
 

Step 5: Set the Optics Zoom Level 

A zoom specification grid is located below the Actuator Control interface. The “Zoom” grid MUST be set 
correctly (at the same value as the zoom indicator on the lens) so that the software can convert image 
tracking data from pixel values to µm values. 

 

 

MicroTester G2 Tip: Setting a Default Software Zoom Level 

The initial software zoom level is stored in the test templates.  This value will be saved to 
the current selected value when saving a template using “Save As Template” from the 
File menu.  

 

Step 6: Adjust the Initial Size Crosshairs 

There are two red crosshairs overlaid on the 
live image.  If the zoom level is set correctly, the 
“Initial Size” field on the left will display the 
distance between these crosshairs.  The 
crosshairs can be moved on the screen by 
clicking on them and dragging them (they will 
turn yellow when they are clickable and can be 
dragged). 

Usually the crosshairs are moved to be 
positioned at the top and bottom of the test 
specimen.   

Note that the absolute distance is measured 
between the crosshairs, not the linear distance 
in one axis. Thus, the crosshairs must be 
aligned horizontally if a correct vertical distance 
is to be measured. 

Initial Size is one of the outputs in the .csv data 
output file. 
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Step 7: Select a Tracking Point 

Select an appropriate tracking point on the microbeam or compression plate by right-clicking on the live 
video window.  A green rectangle or square will appear showing the region that will be used to track this 
location.  The selected point should have some contrast (light/dark) within the green rectangle and should 
not change in appearance due to lighting glare (i.e. it should be a real feature, not an effect created by the 
lighting).  Since force calculations are based on the tracked point locations, accurate tracking is essential 
for accurate force outputs.  

Good choices for the tracking point location, as shown in the following figure, include locations on the 
microbeam wire end or on the compression plate attached to the microbeam.   Features in focus tend to 
track better than features that are out of focus or blurry. 

Good choices on the microbeam include regions of high contrast within the rectangle.  A poor location 
(shown in red) on the microbeam does not have enough contrast within the rectangle for the tracking 
algorithm to uniquely determine its location. 

Good choices on the compression plate will span across a sharp boundary with, for example, the bottom 
half of the green tracking rectangle covering the compression plate and the top half of the tracking rectangle 
not on the compression plate.  Poor choices on the compression plate (shown in red) include locations that 
are overlapping with or close to the specimen (which may change in appearance during compression) or 
do not span across one of the plate edges.  
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Step 8: Execute the Test 

Select Execute from the File menu, or click  on the toolbar. 

 

MicroTester G2 Tip: Check Settings 

Before executing a test, be sure that the microbeam properties and optics zoom level are 
set correctly.  Accurate results are highly dependent on these settings.  Also check the 
position of the initial size crosshairs and tracking point. 

 

Step 9: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File menu.  
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6. Additional Settings 

Camera Shutter and Gain 

Camera settings can be adjusted by selecting 
Equipment from the Settings menu or by pressing 
the Equipment Settings button in the Live Output 
section of the main display window.  The following 
dialog will appear. 

Increasing the camera shutter duration or the 
camera gain makes the image brighter.  
Decreasing either of these parameters makes the 
image darker.  If the gain is too large, the image 
may appear grainy.  If the shutter is too long, the 
image may appear blurry.  These settings are 
stored with the test template file. 

 

 

 

 

 

 

 

 

 

 

 

 

Grid Overlay 

Within the Equipment Settings menu, a grid 
overlay option can be implemented during a trial. 
The spacing can be manually inputted (in pixels). 
Checking the Show check box will display a green 
grid with the specified spacing. 

 Applying a grid overlay can provide many benefits 
during a trial such as distance referencing, beam 
alignment checking, and quadrant mapping.   
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Temperature  

To activate the fluid chamber heater, not only must the ON/OFF switch be turned on, but the 
“ENABLE” button must be pressed so that the HEATER ON indicator is illuminated.  At this point, the 
heater will warm the fluid to the last used temperature set point. The temperature set point can be 
changed by selecting Equipment from the Settings menu.  

Typically, the heater will take 10 to 30 minutes to warm a full fluid chamber from room temperature to 
37°C. 

When Show Temperature Warnings is enabled, and the Current Temperature is not at the 
Temperature Set Point plus or minus the specified tolerance -- a red indicator button will be displayed 
next to the Current Temperature live output and a warning dialog will appear when you execute the 
test. 
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Configuring the Real-Time Graphs 

The three graphs on the right side of the screen provide real-time user feedback during a test. These graphs 
are intended to be used for qualitative feedback, not for detailed analysis.  

The graph settings can be specified by selecting Graphs from the Settings menu. Auto scaling allows the 
axis min and max to start at the specified values but expand if the data values are larger or smaller than 
the initial limits. 

 

It is typical to display Force versus Time, Displacement versus Time and Force versus Displacement as 
shown below.  However, any of the following variables can be plotted in any of the three graphs: 

Force (N) Displacement (um) Time (S) 

Force (mN) Displacement (mm) Temperature  
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Graph Data 

Force versus Time 

This graph shows how the measured forces are 
changing with time. Peak loads per cycle, and force 
relaxation are all easily seen in this type of graph. Force 
is proportional to nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the microbeam is moving with 
time. The phases of the test sequence are readily 
apparent in this type of graph. Displacement is 
proportional to nominal (engineering) strain. 

 

Force versus Displacement 

This graph displays a qualitative representation of the 
material behavior. Viscoelastic effects (like hysteresis) 
and material response to different loading phases are 
apparent in this graph. This graph is proportional to a 
nominal (engineering) stress-strain graph. 

 

 

Data Output Settings 

Select Data Output from the Settings Menu and the following 
dialog will appear. 

Users can specify the *.jpg image file quality that will be used 
for saving collected images. 
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Advanced Settings 

Select Advanced from the Settings menu 
and the following dialog will appear. 

Hold Phase Control allows the user to set 
some limits on actuator movement, in order 
to improve system stability.   

The first parameter limits the maximum 
movement of the vertical stage during each 
control loop iteration.   

The second parameter (“Slow Ratio”) is like 
a safety factor.  For example, if a move of 
10µm is desired in each time step, the 
actuator will attempt to move 10µm X the 
slow ratio.  See the tip below for more 
information. 

Image Tracking Settings allow users to 
control the size of the search region and the 
size of the tracking template.  These 
parameters should normally not be 
changed.   

For systems equipped to measure the X-
Shear axis, a square template and search 
region is recommended. 

 

 

 

MicroTester G2 Tip: Slow Ratio 

For the hold phase of linear elastic materials, both the beam tip and beam base will remain 
close to stationary during a hold phase, so a slow ratio of 0.3-0.5 is appropriate to improve 
stability.  For highly viscoelastic materials, the beam tip will tend to keep moving 
downward at the end of the compression phase, resulting in increasing compression and 
decreasing applied force (due to decreasing beam deflection).  To counteract this, the 
software will have to move the beam base upward for a displacement-controlled test (to 
maintain the current displacement) or downward for a force-controlled test (to maintain 
the current force).  In these situations, a higher slow ratio may be needed.  A ratio of 0.75-
1.0 is relatively stable.  Higher ratios will be even more responsive, but also potentially 
more unstable.  Trial and error may be required to obtain the optimal results for your 
material. 
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7. Reviewing Test Results 

Overview  

The MicroTester G2 software has an integrated image analysis module which can be accessed by selecting 
Analyze and Review Images from the File menu, then selecting the appropriate test file.  The test file is a 
text file with a .tst extension that contains information about the test parameters so that the software can 
display the images and data in a useful fashion.  

The “Analyze and Review Images” module allows for post processing of the test images.  It is used for 3 
main purposes: 

1. Review test for quality assurance purposes 
2. Generate movies and other material for presentations 
3. Trace specimen profiles to calculate geometry values 

 

 

 

Image List 

 

 

 

 

 

Image Playback 

 

 

Image Tracing 

 

 

 

Data Overlay 
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Selecting Images 

The Images are shown in a tree structure on the top left panel. 
The tree structure organizes the images by: 

Set (line on the test parameter window) 

Cycle (iteration of a given Set) 

Phase (Compress/Hold/Recovery/Rest of each Cycle) 

Image (the one or more individual images from each Phase) 

You can select which images to include in a playback set in one 
of several ways: 

• Hold down the shift key and click on individual images 

• Select entire sets, cycles, or phases (will playback all 
contained images) 

• Select images which have data associated with a 
specific tracking set 

 

Image Playback Options 

The controls on the left of the screen are broken into 2 sections: 
Playback and Tracking. The playback buttons allow the user to review 
the images taken during a test. 

 

 

Next/Prev Display next or previous image (as dictated by “Play Every” parameter). 

Play/Stop Start and stop the playback. 

Prev/Next Cycle Jumps to a corresponding image and phase in the next or previous cycle. Useful when reviewing sets that 
have multiple cycles. 

Loop Sequences can be played continuously in a loop or only once. 

Playback Rate +/- changes the speed of the playback. A playback rate can also be manually entered in the display box. 

Play Every Allows the users to skip some frames to expedite playback. 
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Data Overlay 

Data associated with each image is displayed below the 
tracking controls on the left side of the main window.  
Clicking the Show Graph check box will display the 
collected force data associated with this test as a graph 
overlaid on the images.  Clicking on the Show Tracking 
Point check box will display the tracked point used during 
the collection of this test.  Since force calculations are 
based on the tracked point locations, a test where the 
tracked point suddenly jumps or loses its correct location 
indicates invalid force outputs.   

Clicking the details icon  displays the dialog shown 
below.  The user can specify the graph’s size, location and 
appearance. The data points associated with the current 
image are marked on the graph with green circles. The 
overlaid data graph will be drawn on top of any image 
tracking displays (when they overlap).  This can be useful 
for correlating force events with image events and for 
generating presentation material.  
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Exporting Images and Movies 

The current Image view, including all displayed 
tracing data (see section on Image Tracing) and 
overlaid data can be exported as a metafile 
(wmf) by selecting Current Image from the 
Export menu.  Alternately, the current image 
view can be copied to the clipboard by selecting 
Ctrl-C from the keyboard. 

To export a series of image views, including all 
displayed tracing data and overlaid data as an 
.avi movie, select Movie from the Export menu.  
The dialog shown on the right will be displayed.  
The image list is automatically set to the 
currently selected images in the test image list 
tree.  This image list can be changed by 
selecting new images in the test image list tree 
and pressing the set button.   Since there can be 
many images in a single set or phase, clicking 
the “Reduce” button can be useful to remove 
every other frame in the Image List.  This button 
can be used multiple times to pare down the 
image list so that the movie file will not be too 
large.   

Options are available for setting the frame rate 
or image size (resolution), adding filenames, 
and choosing color or grayscale output.  
Compression options are also available. 
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Image Tracing 

Image Tracing is a function that can be used to 
determine aggregate geometries and surface 
tensions during cell aggregate compression 
testing.   

The tracing portion of the screen allows the user 
to create traces, which are associated with a 
specific image.  If the “Display” checkbox is 
checked, then any traces will show up on the 
screen when the images are being viewed.  The 
“Select Images” button will automatically select 
all of images that have associated traces.  This 
is useful if your data set is large and the traced 
images are spread out. 

Clicking “Create” (or if an existing trace exists, 
clicking “Edit”) brings up the following dialog.  
This dialog floats so that it can be positioned to 
allow the user to visualize the image and the 
dialog simultaneously. 
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The general procedure for creating a specimen tracing is as follows: 

1. While the “Add” button is depressed, 
select several points around the perimeter 
of the image. 

 

 

2. Click the “Close Curve” button to attach 
the first and last point. 

 

 

3. Use the “Move” and/or “Insert” buttons to 
modify the points as needed.  There is an 
image zoom feature available on the top 
toolbar if needed. 

 

4. Press “Calculate” to generate the curve fit 
geometries. 

 

 

5. Use the line location adjustment arrows to 
position the vertical lines such that they 
intersect the circles at the point where the 
aggregate surface intersects the 
compression plates. 

 

 

6. Click “OK”  
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Exporting Traced Data 

Geometries and Surface Tensions calculated 
using the image tracing module can be exported 
to a .csv text file by selecting Tracing Results 
from the Export menu. 

The default list contains the images that were 
selected when the “Tracing Results” menu item 
was selected.  Items can be added or deleted 
using the dialog buttons.   
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8. System Calibration and Advanced Tools 

Piezo Calibration 

Piezo Calibration can be selected from the Calibrations submenu of the Tools menu. 

While the vertical piezo stage relies on the displacement sensor for determining the amount of travel, a 
calibration routine is necessary so that the software can estimate the correlation between movement pulses 
and displacement.  This calibration routine will attempt to move the piezo actuator a certain amount and 
will measure the actual movement achieved.  It is recommended that the piezo calibration be performed 
when the equipment is being set up for the first time in your facility.  It is also required to be performed 
whenever the MicroTester G2 software is used on a new computer as the calibration factor is stored on the 
computer. 

Before calibration, make sure the vertical piezo stage is in the mid-range of its travel, preferably at the 
height from which a test will be started. 

The calibration results are reported in the log window on the left side of the main screen.  
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Optics Calibration 

Optics calibration must be completed when the system is first set up and every time the camera and lens 
system is disassembled or changed.  It must also be performed every time a new computer is used to run 
the MicroTester G2.  The procedure is as follows:  

1. Launch the MicroTester G2 software and launch a new test in order to see the live video window. 
2. Bring up the Optics Calibration Dialog by selecting Optics Calibration from the Calibrations 

submenu of the Tools menu. 
3. Position a calibrated target with features of known size on the front of the fluid chamber.  A glass 

target with 10 lines/mm (1mm = 1000 μm) is provided with your equipment for this purpose.  Note 
that this means 10 lines/mm. This target can be positioned with provided holder.  Focus the Image 
using the three axis stages on which the optics and camera are mounted. 

4. Drag the crosshairs on the live video window such that they are positioned a known distance apart.  
Be sure that the crosshairs are aligned with each other as the computer measures the absolute 
distance between them, not just the horizontal or vertical distance. 

5. Enter the distance between the crosshairs in the dialog field. 
6. Select the optics zoom level. 
7. Click the “Calibrate” button in the dialog box. 
8. Selecting the “Apply” button will cause the software to use the current calibration value.  It is useful 

to compare the current calculated value with the previous value as the value should not change 
dramatically.  A typical calibration value is around 0.32 pixels/μm/zoom.  
 

 

Snap Image 

Single Images can be captured and saved from the live video stream by selecting Snap Image from the 
Tools menu. 

This feature allows the user to capture a single image during the setup phase.  This can be useful for 
documenting specimen loading activity and neutral (non-contact) beam position. 
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9. Mounting a MicroBeam 

The exact details of how to best adhere the upper compression plate and mount the microbeam to the grips 
may vary depending on your specific application, but a general protocol is outlined here: 

1. Gather the following materials: 
a. Vertical mounting stage 
b. 1.5mm Hex key 
c. 5/64” hex key 
d. Cyanoacrylate (i.e. Crazy Glue or Loctite 422) 
e. Glue Accelerator 
f. Cotton Swab 
g. Tweezers 
h. Microbeam clamp with M3 fastener 
i. Desired microbeam and compression plate 

 

 

 

2. Bring the vertical stage to its highest point by rotating the knob on the left side. If the stage does 
not move, release the stopper on the right side by rotating and loosening the side screw. 
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3. Align the microbeam clamp to the lip on the face of the stage, and fasten it using a 2.5mm hex key 

and M3 fastener 
 

 
 

4. Loosen the side screw of the microbeam clamp using a 5/64” hex key 
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5. Place microbeam below the clamp opening and lower the stage until the beam is just above the 
tips of the clamp. Tighten the clamp using a 5/64” hex key. This is to ensure the microbeam is 
horizontal. Lift the stage slightly to ensure it is secure affix in the clamp 
 

 

 
 
 

 

 

 

 

6. Place the desired compression plate below the tip of the microbeam. Use tweezers to help ensure 
the tip of the microbeam is in line with the edge of the compression plate 
 

 

  

MicroTester G2 Tip: Microbeam Position 

Very thin and/or delicate microbeams will tend to sag under their own weight (e.g. 100µm 
diameter and smaller metal microbeams).  To ensure that the upper compression plate is 
level after mounting, it may be desirable to initially place the microbeam on an inclined 
surface. 
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7. Place a small dab of glue on the tip of a cotton swap, and place this on the tip of the microbeam 
 

 
 

MicroTester G2 Tip: Cyanoacrylate Adhesive 

Cyanoacrylate adhesive is provided complimentary with the MicroTester G2 system to 
bond the microbeam and compression platen.  This adhesive will best retain its properties 
if it is refrigerated when not being used. 

 

8. Lower the microbeam until it touches the plate 

 

9. Cure the glue by brushing a small amount of glue accelerator 
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10. Lift the stage and remove the clamp from the stage using a 2.5mm hex key to loosen the M3 
fastener 
 

 

 

11. The clamp and microbeam assembly is ready to be mounted to the MicroTester system using the 
M3 fastener and 2.5mm hex key 
 

 

 

MicroTester G2 Warning: Adhesive and Accelerator 

Cyanoacrylate adhesive and accelerator are provided with the MicroTester G2 system to 
bond the microbeam and compression platen.  These are eye, skin, and respiratory 
irritants.  Cyanoacrylate will instantly bond skin.  The use of gloves is recommended. 
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The microbeam clamp is attached to the vertical piezo stage with a single M3 fastener.  This single 
connection allows for the angle of the upper compression plate to be adjusted under guidance from the live 
image.  It is important that the upper compression platen and the lower compression anvil are parallel for 
proper compression testing. 

The microbeam length must be measured and the dimensions and modulus correctly specified before a 
test.  See Section 3 - Step 5 for more details. 

 
 

 

Clamp with microbeam and platen attached to the vertical piezo stage, with testing anvil and 
sample 
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Clamp with MicroBeam and platen attached to the vertical piezo stage, with testing anvil and 
sample 

 

 

Live software camera view MicroBeam and platen, with testing anvil and sample 
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10. Force Calculation Formulas 

The force applied to the specimen is calculated using the deflection of the microbeam according to the 
formula: 

 

𝐷𝑒𝑓𝑙𝑒𝑐𝑡𝑖𝑜𝑛 =  
𝐹𝑜𝑟𝑐𝑒 × 𝐵𝑒𝑎𝑚 𝐿𝑒𝑛𝑔𝑡ℎ3

3 × 𝐵𝑒𝑎𝑚 𝑀𝑜𝑑𝑢𝑙𝑢𝑠 × 𝐵𝑒𝑎𝑚 𝐴𝑟𝑒𝑎 𝑀𝑜𝑚𝑒𝑛𝑡 𝑜𝑓 𝐼𝑛𝑒𝑟𝑡𝑖𝑎
 

where 

𝐵𝑒𝑎𝑚 𝐴𝑟𝑒𝑎 𝑀𝑜𝑚𝑒𝑛𝑡 𝑜𝑓 𝐼𝑛𝑒𝑟𝑡𝑖𝑎 (𝑟𝑜𝑢𝑛𝑑) =  
𝜋 ×  𝑟𝑎𝑑𝑖𝑢𝑠4

4
 

 

𝐵𝑒𝑎𝑚 𝐴𝑟𝑒𝑎 𝑀𝑜𝑚𝑒𝑛𝑡 𝑜𝑓 𝐼𝑛𝑒𝑟𝑡𝑖𝑎 (𝑟𝑒𝑐𝑡𝑎𝑛𝑔𝑢𝑙𝑎𝑟) =  
𝑊𝑖𝑑𝑡ℎ ×  𝐻𝑒𝑖𝑔ℎ𝑡3

12
 

 

Typically, the microbeams are made from tungsten wire.  CellScale has this wire available in 7 different 
diameters.  With a beam length of 55mm, the expected force resolutions and recommended maximum 
forces are given below. 

 

Diameter (mm) 0.0762 0.1016 0.1524 0.2032 0.3048 0.4064 0.5588 1.0160 1.5748 

Modulus (MPa) 411000 411000 411000 411000 411000 411000 411000 411000 411000 

Typical Force 
Resolution (µN) 

0.012 0.038 0.191 0.604 3.056 9.658 34.52 330.54 1907.88 

Recommended 
Max Force (µN) 

4 11 57 181 917 2,897 10,536 99,162 572,363 
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11. Appendix A: System Setup 

Unpack Main Unit, Controllers, and Accessories 

 

Remove the main unit from its packing material.  A foam “clamshell” encases the main unit inside a 
cardboard box for shipping.  This material must be carefully removed.  Take care not to lift the main unit by 
the camera lens or positioning knobs. 

The temperature controller, piezo stage controller, control box, and all system cables and accessories are 
packed in a separate container. 
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Foam Removal from Piezo Stack 

 

  

 

The piezo actuator stack and displacement sensor are protected by a plastic cap.  Foam surrounds these 
components inside the cap during shipping.  Remove the cap using a hex key and remove all pieces of 
foam inside.  Replace the cap and fasteners. 
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Attach Spacer to Vertical Piezo Stage 

 

A spacer is attached to the vertical piezo stage.  This allows the microbeam clamp to reach the test 
chamber.  4 x M3x6 fasteners are used to attach this component using the supplied 2.5mm hex key. 
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Camera Unpacking and Assembly  

 

Remove the plastic cover over the camera stage using the long T-handle 3mm hex key to loosen 3x M4 
screws.  

 

 

Remove the foam surrounding the camera stage and inside the camera cover. 
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The stage is held in place with zip ties and plastic spacer blocks for shipping. Cut the zip ties shown below.  

 

 

First slide the Left/Right stage in the direction below to remove the plastic spacer block. Gently retract 
the stages back towards the motor. The stages are spring loaded and releasing them at full tension 
can result in damage to the motors and/or linear stage itself. 
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Next slide the Forward/Backward stage in the direction below to remove the plastic spacer block. Gently 
retract the stages back towards the motor. The stages are spring loaded and releasing them at full 
tension can result in damage to the motors and/or linear stage itself. 

 

 

Unpackage the camera assembly and attach to camera mount with the included M4 fasteners. 
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The camera assembly can now be fastened on to the stages using an 3mm hex key. 

 

 

The camera USB cable should now be attached and tightened down with the thumb screws. 
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Run USB cable through back hole of top cover. Start lowering the cover unto the camera assembly with the 
ring LED connector placed through the front hole of cover.  

 

 

 

 

  



56 
 

Next attach the camera cover using the long 3mm hex key provided fasten the 3 x M4 cover fasteners 
located below. 
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Remove Lens Cap and Mount the Ring Light on the Lens Assembly 

 

Remove the lens cap from the lens assembly.  Attach the ring light to the end of the lens assembly using 
the 3 set screws spaced around the ring light. 
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Set Test Chamber on the Chamber Holder 

 

Set the fluid bath (test chamber) in the chamber holder on the main unit.  This chamber is pre-assembled 
with a glass slide and gasket.  Replacements are provided for these components. 

Place Temperature Sensor in the Test Chamber 

Bend the temperature sensor into the test chamber.  This chamber can be filled with fluid for which 
temperature control can be specified.  The temperature sensor functions best when it is fully immersed in 
fluid and is not touching the side of the chamber. 
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Connect Cables 

Few power and communication cables need to be connected between the main unit, a power supply, and 
a computer: 

• 20V power supply to power input jack on the main unit 

• LED ring light to control box power extension 

• USB Cable to back of camera (do not yet connect to PC) 

• USB Cable for Piezo board, Arduino DUE board, and position sensor (control box hub)  
 

NOTE: At the completion of this step, there should be 2 USB connections ready to connect to the PC USB 
ports 

• Black USB cable from camera (this will require a USB 3.0 port) 

• Black USB cable from USB hub in control box controlling displacement sensor module, Arduino 
DUE board, and Piezo control board. 
 

 
 

   

 

 

 

Remember to tighten camera USB connection by rotating the 2 pin fasteners on the cable.  

Camera USB  
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System Calibration Check 

After the MicroTester G2 is fully assembled and set up, the MicroTester G2 software must be installed (see 
Appendix B).  The system can then be switched on and the computer connectivity may be tested by opening 
an initial test.  However, before any tests are run, it is recommended to check the piezo and optics 
calibrations.  Instructions for these operations can be found in Section 8: System Calibration and Advanced 
Tools. 

 

LED Ringlight 
power connector 
and plug 
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12. Appendix B: Software Installation 

1. Download the software installation package from the provided link and save to a known location   
2. After this is complete, go to the uncompressed installation folder and select MicroTester 

Installer.exe.  Details of typical dialogue boxes are shown below. 
3. Follow the prompts as shown on the next few pages. 
4. Once the installer is finished, plug the USB cables into a USB port for the following components: 

• Camera (black USB cable) 

• Position Sensor, Piezo Actuator Controller, and Arduino DUE USB hub cable  
 
The MicroTester G2 requires at least 2 USB ports for operation.   
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If your MicroTester is detected this screen will popup: 

 

If MicroTester is not detected, then you will be taken to a model selection screen where you can select your 
MicroTester model. To install the correct user manual and templates please select the appropriate model. 
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Update Firmware 

Periodic firmware updates may be issued by CellScale for the MicroTester. When a new firmware or 
software is available, you may download it from our website (www.cellscale.com/downloads).  

To update the firmware: 

1. Connect the MicroTester to the PC via USB and turn on power to the MicroTester 
2. Open the UpdateFirmware.exe program located in MicroTester>Software>Utilities>Update 

Firmware  
3. The program will automatically update the firmware of the MicroTester 
4. Power cycle the system after the firmware is successfully updated before using the MicroTester 

software again 
 
The firmware version is checked and the automatic updater is also run when installing a new 
version of the software. 
 

 

  

http://www.cellscale.com/downloads


66 
 

If the automatic firmware update software does not work, please follow the manual steps below: 

1. With the MicroTester connected to the PC and turned on, launch the manual firmware update 
software located in MicroTester>Utilities>Update Firmware>Advanced. 

2. Click the Connect button. 
3. Load the firmware file using the Browse button. The file will be a .bin extension. 
4. Execute the update using the Update button. 
5. Power cycle the system after the firmware is successfully updated before using the MicroTester 

software again. 
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13. Appendix C: Shear Testing 

 

 

Some MicroTester G2 systems are equipped with an additional displacement sensor to measure horizontal 
displacement of the microbeam during a test so that tests can be executed in this axis.  This allows a type 
of shear testing to be performed on samples.   
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Installing the Shear Axis Keyence Sensor 

 

1. Unbox the Keyence sensor from its box, it should have a collar and nut installed on the 

measuring end.  This item is very sensitive, use caution when handling 

 

 
 

2. Next, remove the nut from the collar 
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3. Carefully slide the Keyence probe into the shear axis mounting bracket, when doing this slide the 

nut on and finger tighten it in place.  

 
4. Using supplied wrench tighten the nut to hold Keyence sensor in place.  Be aware you do not 

want to overtighten this nut as it can damage the sensor. 

 
 
 
 

5. Next, insert cable into the back end of the sensor and install cover to complete installation 
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On systems equipped for shear testing, a special version of the software is provided directly to the user 
(the link on the CellScale website contains the single-axis version of the software).  In the “Set Parameter 
Editor”, this allows X-Shear to be selected as the Control Axis.  Compression and Shear movements can 
be executed in the same test sequence by selected a different Control Axis for different test sets.  For shear 
testing, positive magnitudes are to the right.   
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Additional data columns for the X-Shear axis are output in the data .csv file for these specially equipped 
systems.  In addition, the live graphs during a test will contain additional data output for this axis. 
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Also, the image tracking settings will typically differ from that of a single axis MicroTester G2 system.  The 
tracking template and search region settings can be found in Advanced in the Settings menu.  This will be 
preset as a square dialog box under the demo template provided so that image tracking can be performed 
equally well in both axes.  If single axis testing is being performed, these settings can be altered so that the 
template and search region is optimized for the axis being used.  
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14. Appendix D: Camera Lens Attachment 

The MicroTester G2 system features a camera lens tube with an operating detent mechanism. This 
prevents accidental slippage during experimentation, giving a consistent and crisp focus view of the 
intended target. The standard MicroTester G2 comes with an already-attached camera assembly. This 
standard assembly includes the camera bracket (short), camera, objective tube (1x), and auxiliary lens (1x). 
The standard assembly is depicted below. 

 

 

 

The standard MicroTester G2 also comes with the 2x camera objective tube, 2x mounting bracket, and 2x 
auxiliary lens for different applications seen below. Changing either the objective tube OR the auxiliary lens 
will have the effect of doubling the magnification. Change BOTH will have the effect of increasing the 
magnification by a factor of 4. 
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In order to replace the auxiliary lens, slowly rotate the attached piece counter clockwise. Be careful not to 
touch any exposed lens. Attach the wanted auxiliary lens by slowly rotating the part clockwise onto the 
camera lens tube until a snug fit is apparent. Changing the auxiliary lens will change the working distance 
of the optics and thus require changing the mounting bracket. 
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In order to replace the objective tube, first loosen the 2 set screws (circled in red) from the camera bracket 
and take off camera assembly from MicroTester G2 device. 

 

 

 

Remove the camera from the objective tube by slowly rotating (counter clockwise) the camera. 
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To change between 1x and 2x objective tubes: 

1. Locate ring B which only has 2 screws and loosen them  

a. Do not loosen screws on ring A and C! 

 

2. Gently pull the tube assembly out and replace it with the desired tube 

 

a. Ensure the new tube is pushed up against the side of ring A 

 

3. Tighten both screws at B 

4. Screw the lens assembly back onto the camera 

5. Place the assembly into the appropriate bracket and tighten the set screws to hold it in place 

a. Use the longer bracket when using the 2x objective tube, and the shorter bracket with the 

1x tube 

  

A B C 

Ring A 

New objective 
tube 
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Take camera system and line detent clip with the horizontal set screw. Carefully push camera system back 
into the intended bracket. The short bracket is meant for the 1x auxiliary lens while the longer bracket is for 
the 2x auxiliary lens. Rotate camera system counter-clockwise until detent clip is facing downwards. Tighten 
set screws.  
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15. Appendix E: Attaching Secondary Camera 

 

An additional option for the MicroTester G2 is a secondary camera axis that allows you to view your sample 
from the side.  This option includes an anodized aluminum bracket what mounts to the side of the device. 
This bracket is help on by 4x M4x12 fasteners.   

To attach this bracket the bottom cover must first be removed, this is done by carefully laying the system 
on its side.  It is recommended to support the piezo motor cover with a piece of foam or something soft, so 
you do not scratch the surface.  Once the system is on its side remove 6 M3x6 flat head fasteners using 
the provided 2mm hex key 

 

 

The bracket will attach to the 4 holes shown below. 
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When the system is on its side set the bracket in place and fasten it with provided fasteners. 

  

 

Attach the camera bracket to the top fo the XYZ stage using the supplied M4 fasteners. 
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Slide the additional spacer over the lens. Place the camera lens through the camera bracket and secure it 

in place by tightening the M3x8 set screws with a 2.5mm hex key. Ensure the spacer is place behind the 

bracket as shown below. 

Secure the secondary ring light over the lens. 

 

 

Connect the USB cable to the camera and plug it into a USB 3.0 port on your computer. 

To utilize the secondary camera feature, start a new test with the ‘demo2Camera’ template provided with 

the MicroTester software. You may edit this template as needed to suit your sample and testing 

requirements. Remember to save your changes by using the ‘Save as a new Template’ under the ‘File’ 

drop down menu. 

 

  

Lens spacer 
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If you are running a test near the edge of the media dish, it may be difficult to focus the secondary 

camera due to the radius of the corner on the plastic dish. We recommend sliding the dish forward slightly 

to allow the secondary camera to focus on your specimen. 

  

Depending on where your MicroTester is set up, it may be helpful to place a small piece of white paper 

along the left edge of the dish (when looking at the beam head on). This will eliminate any background 

objects from being captured and help with reflecting light towards the camera. 
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16. Appendix F: Software Troubleshooting 

This software is recommended for use with a Windows 10 operating system. Use on Windows 7 systems 
may result in some hardware communication errors with the MicroTester, such as the following: 

 

Issue: MicroTester software cannot communicate with camera and/or controller 

 

         

 

Solution: This is often caused by turning off the device while the software is still running on Windows 7, 
then trying to reopen the software. If you encounter this error, try closing and turning everything off, 
removing and reinserting the USBs, then try again. Make sure both USBs and the power supply are plugged 
in and the device is on before you launch the software. You can also try manually renumbering the port 
numbers for the USB port being used by the MicroTester controller in your computers Device Manager > 
Ports. Finally, try restarting your computer. 
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17. Appendix G: Accessories 

The MicroTester has different accessories to conduct testing on your samples. We will utilize the first 5 
steps from Section 9. Mounting a MicroBeam. After completing the steps, your beam should look like the 
following: 

 

Once you have your beam to at this stage, follow the following steps depending on the accessory. The 
general protocol on the setup of each accessory is outlined but this might vary depending on your specific 
application.  

Tension Forks 

1. Place the desired tension fork below the tip of the microbeam. Use tweezers to align the tension 
fork and ensure the tip of the microbeam is in line with the edge of the fork. Ensure that the tension 
fork is not at an angle. 
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2. Apply a dab of glue using the cotton swab and then cure the glue by brushing a small amount of 
glue accelerator. 
 

 
 
3. Lift the stage and remove the clamp using a 2.5mm hex key. Attach the clamp to the MicroTester 

system.  
 
4. Take the bottom tension fork and attach your sample carefully using tweezers. 

 

 
 
5. Place this in the media bath. Slide the bath away from the upper tension fork. Make sure both sets 

of forks are facing the camera. 
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6. Using tweezers and moving the bath back, puncture the sample with the upper fork. 
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3-Point Bend 

1. Gather the specific sized U-Channel (3mm or 5mm spacing) and place it in the bath. 
 

 
 

2. Place your sample on top of the U-Channel. You may use some type of adhesive to ensure that 
the sample does not move. 

 

 

 

3. Place the second U-Channel on top of the sample. 
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4. Install the microbeam without any fixtures on the end. Note: The bath will need to be moved forward 
slightly. 

 

 

 

5. Align the beam to be within the U-Channel and above the sample. Remember to push the bath 
back to its original position.  
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Spherical Indentation 

 
1. Place the desired spherical indenter below the tip of the microbeam. Use tweezers to ensure the 

tip of the microbeam is centered with the indenter. You may also create an indentation in the vertical 
stage to limit the indenters’ movement. 
 

 

 

2. Apply a small dap of glue from the tip of the cotton swab while holding the indenter with the 
tweezers. Cure the glue by brushing a small amount of glue accelerator. 
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